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Introduction

A Petzval lens comprises two positive lens groups that are separated by air. By using a pair 
of doublets, astigmatism can be controlled over restricted fields of view with modest 
numerical apertures.

The basic Petzval lens configuration will invariably result in a best focus image surface that 
is concave. This can be corrected by placing a negative lens element as close as possible to 
the image plane. In this tutorial, a field-flattened Petzval will be demonstrated.

Figure 1: Overview of the Petzval lens. The lens includes a field-flattening element. In this 
view the marginal rays of an on-axis trace are shown, together with the chief ray of 5 
additional fields.

Model Definition

The field-flattened Petzval lens simulated in this study is based on the prescription from 
Ref. 1, p. 191. The focal length is 100.0 mm and the focal ratio is approximately f/2.4. 
An overview of the lens layout can be seen in Figure 1, and the parameters of this lens are 
shown in Table 1. Note that some of the lens materials have replaced with equivalents from 
the built-in Optical material library and the back focal length has been adjusted.
2 |  P E T Z V A L  L E N S



The instructions for creating the lens geometry can be found in the Appendix — 
Geometry Instructions. In addition to the lens parameters used to define the lens 
geometry, a set of parameters are required to define the ray trace. These are detailed in 
Table 2.

Several of the parameters defined in Table 2 are used to derive additional parameters such 
as the ray direction vector components, the stop and image plane z-coordinates, and the 
entrance pupil location. Table 3 gives the expressions used to derive these parameters. 
Note that the pupil shift factor is an empirical approximation to ensure that the chief ray 
passes through the center of the stop at all field angles.

TABLE 1:  PETZVAL LENS PARAMETERS.

Index Name Radius 
(mm)

Thickness 
(mm)

Material Clear radius 
(mm)

— Object ∞ ∞ — —

1 Lens 1 98.45049 13.00000 N-BK7 28.478

2 Lens 2 -83.29386 4.00000 N-KZFS5 26.267

— — -1421.38828 40.00000 — 22.020

3 Stop ∞ 40.00000 — 16.631

4 Lens 3 59.00613 12.00000 N-SK2 20.543

5 Lens 4 -54.36470 3.00000 N-SF5 20.074

— — -549.36547 46.82210 — 16.492

6 Lens 5 -39.80076 2.00000 N-SF5 17.297

— — ∞ 1.9548 — 18.940

— Image ∞ — — 17.904

TABLE 2:  GLOBAL PARAMETER DEFINITIONS.

Parameter Value Description

λvac 475nm, 550nm, 625nm Nominal (vacuum) wavelengths

θx 0° Nominal x field angle

θy 0°, 6°, 9° Nominal y field angles

Nring 12 Number of hexapolar rings. (Nring = 12 will give 
a total of 469 rays.)

Pnom 41.5 mm Nominal entrance pupil diameter

Pfac1 -1.142 Pupil shift factor 1

Pfac2 -0.080 Pupil shift factor 2
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Results and Discussion

In this simulation the lens geometry is constructed by repeated insertions of part instances 
from the COMSOL Part Libraries. Each lens element is inserted sequentially, such that 
each subsequent lens is placed relative to the prior one. This process is simplified by 
making use of the predefined work planes within the “Spherical Lens 3D” part instance.

It is important to appreciate that the ray tracing method used by the Geometrical Optics 
interface is inherently non-sequential, so the same result could be obtained by placing part 
instances within the geometry in any order. In order to limit the rays to those that reach 
the focal plane, additional aperture stops and obstructions are added to the geometry. 
These items can also be placed by using the predefined work planes from each of the lens 
part instances. The Petzval lens geometry sequence is shown in Figure 2 and the mesh can 
be seen in Figure 3.

TABLE 3:  GLOBAL PARAMETER DEFINITIONS (DERIVED).

Parameter Value Description

vx tanθx Ray direction vector, x-component

vy tanθy Ray direction vector, y-component

vz 1 Ray direction vector, z-component

zstop Stop z-coordinate, where Tc,n is the central 
thickness of element n and Tn is the 
separation between elements n and n+1. 
Note that the stop is the 3rd element in the 
Petzval lens.

zimage Image plane z-coordinate, where Tc,n is the 
central thickness of element n and Tn is the 
separation between elements n and n+1. 
Including the stop, the Petzval lens has 6 
elements.

Pfac Pfac1 + Pfac2 sinθ
Pupil shift factor, where 

Δxpupil (Δzpupi + Pfac zstop)tanθx Pupil shift, x-coordinate

Δypupil (Δzpupi + Pfac zstop)tanθy Pupil shift, y-coordinate
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Figure 2: The Petzval lens geometry sequence.

Figure 3: The Petzval lens mesh.
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A ray trace has been performed at three wavelengths (475 nm, 550 nm, and 625 nm) and 
three field angles (on-axis, 6°, and 9°). In Figure 4 the ray trajectories can be seen colored 
by optical path length. The slice plot in the background of this figure indicates the d-line 
refractive index nd of each material, which highlights the disparity in refractive index 
between the crown and flint glasses of each cemented doublet. In Figure 5, a color 
expression based on the location of the rays at the image plane is used. This allows the 
relative contribution of rays at the pupil to the final image quality to be easily visualized.

Finally, in Figure 6 a spot diagram is shown. In this plot the points are colored according 
to their initial location in the pupil. This complements the coloring of the ray diagram in 
Figure 5.

Figure 4: Ray diagram of the Petzval lens colored by radial distance from the centroid.
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Figure 5: Ray diagram of the Petzval lens where the rays are colored by their radial distance 
from the centroid on the image plane.

Figure 6: Spot diagram for the Petzval lens. The color indicates the wavelength.
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Application Library path: Ray_Optics_Module/Lenses_Cameras_and_Telescopes/
petzval_lens

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Optics>Ray Optics>Geometrical Optics (gop).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Ray Tracing.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters 1: Lens Prescription
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Parameters 1: Lens Prescription in 
the Label text field. The lens prescription will be added when the geometry sequence is 
inserted in the following section.

Parameters 2: General
The Petzval Lens simulation parameters can be loaded from a text file.

1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Parameters 2: General in the Label text 
field.

3 Locate the Parameters section. Click Load from File.
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4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_parameters.txt.

P E T Z V A L  L E N S

Insert the prepared geometry sequence from file. You can read the instructions for creating 
the geometry in the appendix. Following insertion, the lens definitions will be available in 
the Parameters node.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

4 In the Label text field, type Petzval Lens.

5 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.

6 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_geom_sequence.mph.

7 In the Geometry toolbar, click Build All.

8 Click the Orthographic Projection button in the Graphics toolbar.

9 In the Graphics window toolbar, click next to Go to Default View, then choose 
Go to ZY View. This will orient the view to place the optical axis (z-axis) horizontal and 
the y-axis vertical. Compare the resulting geometry to Figure 2.

A D D  M A T E R I A L

1 In the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Optical>Schott Glass>Schott N-BK7 Glass.

4 Click Add to Component in the window toolbar.

5 In the tree, select Optical>Schott Glass>Schott N-KZFS5 Glass.

6 Click Add to Component in the window toolbar.

7 In the tree, select Optical>Schott Glass>Schott N-SK2 Glass.

8 Click Add to Component in the window toolbar.

9 In the tree, select Optical>Schott Glass>Schott N-SF5 Glass.

10 Click Add to Component in the window toolbar.

11 In the Home toolbar, click Add Material to close the Add Material window.
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M A T E R I A L S

Schott N-BK7 Glass (mat1)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Schott N-

BK7 Glass (mat1).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Lens Material 1.

Schott N-KZFS5 Glass (mat2)
1 In the Model Builder window, click Schott N-KZFS5 Glass (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Lens Material 2.

Schott N-SK2 Glass (mat3)
1 In the Model Builder window, click Schott N-SK2 Glass (mat3).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Lens Material 3.

Schott N-SF5 Glass (mat4)
1 In the Model Builder window, click Schott N-SF5 Glass (mat4).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Lens Material 4.

G E O M E T R I C A L  O P T I C S  ( G O P )

1 In the Model Builder window, under Component 1 (comp1) click Geometrical Optics (gop).

2 In the Settings window for Geometrical Optics, locate the Ray Release and Propagation 
section.

3 From the Wavelength distribution of released rays list, choose Polychromatic,

specify vacuum wavelength. The list of polychromatic wavelengths will be entered 
below.

4 In the Maximum number of secondary rays text field, type 0. In this simulation stray light 
is not being traced, so reflected rays will not be produced at the lens surfaces.

5 Locate the Material Properties of Exterior and Unmeshed Domains section. From the 
Optical dispersion model list, choose Air, Edlen (1953). The lenses are assumed to be 
surrounded by air at room temperature.
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Medium Properties 1
1 In the Model Builder window, under Component 1 (comp1)>Geometrical Optics (gop) click 

Medium Properties 1.

2 In the Settings window for Medium Properties, locate the Medium Properties section.

3 From the Refractive index of domains list, choose Get dispersion model from material. 
Each of the materials added above contain the optical dispersion coefficients which can 
be used to compute the refractive index as a function of wavelength.

Material Discontinuity 1
1 In the Model Builder window, click Material Discontinuity 1.

2 In the Settings window for Material Discontinuity, locate the Rays to Release section.

3 From the Release reflected rays list, choose Never.

Release from Grid 1
Release the rays from a hexapolar grid, using quantities defined in the Parameters node.

1 In the Physics toolbar, click Global and choose Release from Grid.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 From the Grid type list, choose Hexapolar.

4 Specify the qc vector as

The Center location of the hexapolar grid will change according to the field angle.

5 Specify the rc vector as

The Cylinder axis direction is the same as the global optical axis.

6 In the Rc text field, type P_nom/2.

7 In the Nc text field, type N_ring.

dx1 x

dy1 y

dz z

nix x

niy y

niz z
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8 Locate the Ray Direction Vector section. Specify the L0 vector as

The Ray direction vector is calculated using the field angles defined in the Parameters 
node.

9 Locate the Vacuum Wavelength section. From the Distribution function list, choose 
List of values.

10 In the Values text field, type 475[nm] 550[nm] 625[nm].

Release from Grid 2
1 Right-click Release from Grid 1 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 Specify the qc vector as

4 Locate the Ray Direction Vector section. Specify the L0 vector as

Release from Grid 3
1 Right-click Release from Grid 2 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 Specify the qc vector as

4 Locate the Ray Direction Vector section. Specify the L0 vector as

vx1 x

vy1 y

vz z

dx2 x

dy2 y

vx2 x

vy2 y

dx3 x

dy3 y

vx3 x

vy3 y
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Obstructions
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Obstructions in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Obstructions.

4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.

Stop
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Stop in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Aperture Stop.

4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.

Image
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Image in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Image Plane.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Physics-Controlled Mesh section.

3 From the Element size list, choose Fine. Slightly refine the mesh for this study to ensure 
that rays passing close the edge of apertures are traced.

4 Click Build All. The mesh should looks like Figure 3.

S T U D Y  1

Step 1: Ray Tracing
1 In the Model Builder window, under Study 1 click Step 1: Ray Tracing.

2 In the Settings window for Ray Tracing, locate the Study Settings section.

3 From the Time-step specification list, choose Specify maximum path length.

4 From the Length unit list, choose mm.

5 In the Lengths text field, type 0 200. The maximum optical path length is sufficient for 
rays released at large field angles to reach the image plane.

6 In the Home toolbar, click Compute.
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R E S U L T S

Ray Diagram 1
Create a plot showing the ray trajectories, as well as a spot diagram showing the 
intersection of the rays with the image plane.

1 In the Settings window for 3D Plot Group, type Ray Diagram 1 in the Label text field.

2 Locate the Color Legend section. Select the Show units check box.

3 From the Position list, choose Bottom.

4 In the Model Builder window, expand the Ray Diagram 1 node.

Color Expression 1
1 In the Model Builder window, expand the Results>Ray Diagram 1>Ray Trajectories 1 

node, then click Color Expression 1.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type at('last',gop.rrel). This is the radial coordinate 
relative to the centroid of each release feature at the image plane.

4 From the Unit list, choose µm.

Filter 1
1 In the Model Builder window, click Filter 1.

2 In the Settings window for Filter, locate the Ray Selection section.

3 From the Rays to include list, choose Logical expression.

4 In the Logical expression for inclusion text field, type at(0,
abs(gop.deltaqx))<1[mm].

Cut Plane 1
In the Results toolbar, click Cut Plane.

Surface 1
1 In the Model Builder window, right-click Ray Diagram 1 and choose Surface.

2 In the Settings window for Surface, locate the Data section.

3 From the Dataset list, choose Cut Plane 1.

4 Click Replace Expression in the upper-right corner of the Expression section. From the 
menu, choose Component 1 (comp1)>Geometrical Optics>Refractive index>gop.nrefd -

Refractive index, d-line.

5 Locate the Coloring and Style section. Click Change Color Table.

6 In the Color Table dialog box, select Linear>GrayScale in the tree.
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7 Click OK.

Line 1
1 Right-click Ray Diagram 1 and choose Line.

2 In the Settings window for Line, locate the Data section.

3 From the Dataset list, choose Cut Plane 1.

4 From the Time (s) list, choose 0.

5 Locate the Coloring and Style section. From the Coloring list, choose Uniform.

6 From the Color list, choose Black.

7 In the Ray Diagram 1 toolbar, click Plot. Compare the resulting image to Figure 4.

Ray Diagram 2
For the second ray diagram the rays will be colored according to the radial distance from 
the ray’s location in the image plane to the centroid. This makes it possible to visualize 
which rays are contributing to the image plane spot aberrations.

1 In the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Ray Diagram 2 in the Label text field.

3 Locate the Data section. From the Dataset list, choose Ray 1.

4 Locate the Plot Settings section. From the View list, choose New view.

5 Locate the Color Legend section. Select the Show units check box.

Ray Trajectories 1
In the Ray Diagram 2 toolbar, click More Plots and choose Ray Trajectories.

Color Expression 1
1 Right-click Ray Trajectories 1 and choose Color Expression.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type at('last',gop.rrel). This is the radial coordinate 
relative to the centroid of each release feature at the image plane.

4 From the Unit list, choose µm.

Add a Surface plot to render the lens elements as solids.

Surface 1
1 In the Model Builder window, right-click Ray Diagram 2 and choose Surface.

2 In the Settings window for Surface, locate the Data section.

3 From the Dataset list, choose Study 1/Solution 1 (sol1).
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4 Locate the Coloring and Style section. From the Coloring list, choose Uniform.

5 From the Color list, choose Gray.

Selection 1
1 Right-click Surface 1 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Lens Exteriors.

Transparency 1
1 In the Model Builder window, right-click Surface 1 and choose Transparency.

2 In the Ray Diagram 2 toolbar, click Plot.

3 Click the Orthographic Projection button in the Graphics toolbar. Orient the view to 
match Figure 5 to show the all the rays.

Spot Diagram
In the following steps, a spot diagram is created, and a custom color expression is added.

1 In the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Spot Diagram in the Label text field.

3 Locate the Color Legend section. Select the Show units check box.

Spot Diagram 1
In the Spot Diagram toolbar, click More Plots and choose Spot Diagram.

Color Expression 1
1 Right-click Spot Diagram 1 and choose Color Expression.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type gop.lambda0.

4 From the Unit list, choose nm.

5 Click to expand the Range section. Select the Manual color range check box.

6 In the Minimum text field, type 450.

7 In the Maximum text field, type 650.

8 In the Spot Diagram toolbar, click Plot.

9 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting 
image to Figure 6.
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Appendix — Geometry Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 Click Done.

G L O B A L  D E F I N I T I O N S

The detailed parameters of the lens can be imported from a text file. The prescription for 
the Petzval lens with a field flattener can be found in Ref. 1, pg 192.

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_geom_sequence_parameters.txt.

Petzval Lens Parameters
The parameters that define the Petzval lens geometric sequence are found in 
petzval_lens_geom_sequence_parameters.txt. These will be described in the tables 
below.

1 First, define the global optical axis. This is used to orient the first lens only. The 
orientation of each subsequent lens will be relative to the preceding one.

Parameter Description

nix Global optical axis, x-component

niy Global optical axis, y-component

niz Global optical axis, z-component
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2 Next, define the parameters for each of the lens elements. Each lens requires 8 
parameters in addition to the ray incident directions (which are set using the global 
values).

3 Finally, define the remaining lens parameters.

P E T Z V A L  L E N S  G E O M E T R Y  S E Q U E N C E

Start constructing the lens geometry.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, type Petzval Lens Geometry Sequence in the 
Label text field.

3 Locate the Units section. From the Length unit list, choose mm.

Insert the first of the Petzval Lens elements.

P A R T  L I B R A R I E S

1 In the Home toolbar, click Windows and choose Part Libraries.

2 In the Part Libraries window, select Ray Optics Module>3D>Spherical Lenses>

spherical_lens_3d in the tree.

3 Click Add to Geometry.

Parameter Description

R1_[n] Radius of curvature, surface 1, lens [n]

R2_[n] Radius of curvature, surface 2, lens [n]

Tc_[n] Center thickness, lens [n]

d0_[n] Outer diameter, lens [n]

d1_[n] Diameter, surface 1, lens [n]

d2_[n] Diameter, surface 2, lens [n]

d1_clear_[n] Clear aperture diameter, surface 1, lens [n]

d2_clear_[n] Clear aperture diameter, surface 2, lens [n]

Parameter Description

T_[n] Distance between lenses [n] and [n+1].

d0_S Stop maximum (outer) diameter

d1_S Stop minimum (clear) diameter

d0_D Diameter of image plane
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4 In the Select Part Variant dialog box, select Specify clear aperture diameter in the 
Select part variant list.

5 Click OK. This part is used for each of the 5 Petzval Lens elements.

P E T Z V A L  L E N S  G E O M E T R Y  S E Q U E N C E

Lens 1
1 In the Model Builder window, under Component 1 (comp1)>

Petzval Lens Geometry Sequence click Spherical Lens 3D 1 (pi1).

2 In the Settings window for Part Instance, type Lens 1 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_geom_sequence_lens1.txt. The files 
petzval_lens_geom_sequence_lens[m,m=1..5].txt contains references to each of 
the individual lens parameters. This avoids having to enter the values manually. Note 
that the z-axis is the optical axis throughout this geometry; that is, nix=niy=0, niz=1.

5 Click Build Selected.

6 Click the Orthographic Projection button in the Graphics toolbar.

7 In the Graphics window toolbar, click next to Go to Default View, then choose 
Go to ZY View. This will orient the view to place the optical axis (z-axis) horizontal and 
the y-axis vertical.

Create cumulative selections defining the materials, clear apertures, obstructions and 
image plane that can be used within the final ray trace.

Cumulative Selections
In the Geometry toolbar, click Selections and choose Cumulative Selections.

Lens Material 1
1 Right-click Cumulative Selections and choose Cumulative Selection.

2 In the Settings window for Selection, type Lens Material 1 in the Label text field.

Lens Material 2
1 In the Model Builder window, right-click Cumulative Selections and choose 

Cumulative Selection.

2 In the Settings window for Selection, type Lens Material 2 in the Label text field. In 
the same manner, add selections for Lens Material 3, Lens Material 4, Lens 
Exteriors, Clear Apertures, Obstructions, Aperture Stop, and Image Plane.
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Lens 1 (pi1)
Now, apply these selections.

1 In the Model Builder window, under Component 1 (comp1)>

Petzval Lens Geometry Sequence click Lens 1 (pi1).

2 In the Settings window for Part Instance, click to expand the Domain Selections section.

3 In the table, enter the following settings:

4 Click to expand the Boundary Selections section. In the table, enter the following 
settings:

Lens 2
Continue constructing the lens. Add the second lens element.

1 In the Geometry toolbar, click Parts and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 2 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_geom_sequence_lens2.txt.

Each lens element can be positioned in the geometry by referencing it to an existing 
work plane. For this example, use a work plane that is defined by the vertex on the exit 
surface of the prior lens element.

5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 1 (pi1).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

Name Keep Physics Contribute to

All √ Lens Material 1

Name Keep Physics Contribute to

Exterior √ Lens Exteriors

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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7 Find the Displacement subsection. In the zw text field, type T_1. This is the distance 
along the optical axis between the exit surface of lens 1 and the entrance surface of lens 
2.

8 Locate the Domain Selections section. In the table, enter the following settings:

9 Locate the Boundary Selections section. In the table, enter the following settings:

P A R T  L I B R A R I E S

Next, insert the stop.

1 In the Geometry toolbar, click Parts and choose Part Libraries.

2 In the Part Libraries window, select Ray Optics Module>3D>Apertures and Obstructions>

circular_planar_annulus in the tree.

3 Click Add to Geometry. This part is also used to define the image plane and 
additional obstructions.

P E T Z V A L  L E N S  G E O M E T R Y  S E Q U E N C E

Stop
1 In the Model Builder window, under Component 1 (comp1)>

Petzval Lens Geometry Sequence click Circular Planar Annulus 1 (pi3).

2 In the Settings window for Part Instance, type Stop in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Keep Physics Contribute to

All √ Lens Material 2

Name Keep Physics Contribute to

Exterior √ Lens Exteriors

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions

Name Expression Value Description

d0 d0_S 58 mm Diameter, outer

d1 d1_S 33.262 mm Diameter, inner
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4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 2 (pi2).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zw text field, type T_2+Tc_3.

7 Locate the Boundary Selections section. In the table, enter the following settings:

Lens 3
The remaining lenses are similarly defined. Next, add the third lens element.

1 In the Geometry toolbar, click Parts and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 3 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_geom_sequence_lens3.txt.

5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Stop (pi3).

6 From the Work plane list, choose Surface (wp1).

7 Find the Displacement subsection. In the zw text field, type T_3.

8 Locate the Domain Selections section. In the table, enter the following settings:

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz 1 1 Local optical axis, z-component

Name Keep Physics Contribute to

All √ Aperture Stop

Name Keep Physics Contribute to

All √ Lens Material 3

Name Expression Value Description
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9 Locate the Boundary Selections section. In the table, enter the following settings:

Lens 4
Next, add the fourth lens element.

1 In the Geometry toolbar, click Parts and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 4 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_geom_sequence_lens4.txt.

5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 3 (pi4).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subsection. In the zw text field, type T_4.

8 Locate the Domain Selections section. In the table, enter the following settings:

9 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to

Exterior √ Lens Exteriors

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions

Name Keep Physics Contribute to

All √ Lens Material 4

Name Keep Physics Contribute to

Exterior √ Lens Exteriors

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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Lens 5
Now, add the fifth and last lens element. This element gives the Petzval a flat image plane.

1 In the Geometry toolbar, click Parts and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 5 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_geom_sequence_lens5.txt.

5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 4 (pi5).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subsection. In the zw text field, type T_5.

8 Locate the Domain Selections section. In the table, enter the following settings:

9 Locate the Boundary Selections section. In the table, enter the following settings:

P A R T  L I B R A R I E S

Define the square image plane.

1 In the Geometry toolbar, click Parts and choose Part Libraries.

2 In the Part Libraries window, select Ray Optics Module>3D>Apertures and Obstructions>

rectangular_planar_annulus in the tree.

3 Click Add to Geometry.

Name Keep Physics Contribute to

All √ Lens Material 4

Name Keep Physics Contribute to

Exterior √ Lens Exteriors

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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P E T Z V A L  L E N S  G E O M E T R Y  S E Q U E N C E

Image
1 In the Model Builder window, under Component 1 (comp1)>

Petzval Lens Geometry Sequence click Rectangular Planar Annulus 1 (pi7).

2 In the Settings window for Part Instance, type Image in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 5 (pi6).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zw text field, type T_6.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build All Objects.

9 Click the Zoom Extents button in the Graphics toolbar.

Create a selection that includes all lenses. This can be used to define physics features.

All Lenses
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type All Lenses in the Label text field.

Name Expression Value Description

w0 d0_D 35.808 mm Width, outer

h0 d0_D 35.808 mm Height, outer

w1 0 0 m Width, inner

h1 0 0 m Height, inner

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz 1 1 Local optical axis, z-component

nwx 1 1 Rectangle width direction, x component

nwy 0 0 Rectangle width direction, y component

nwz 0 0 Rectangle width direction, z component

Name Keep Physics Contribute to

All √ Image Plane
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3 On the object pi1, select Domain 1 only.

4 On the object pi2, select Domain 1 only.

5 On the object pi4, select Domain 1 only.

6 On the object pi5, select Domain 1 only.

7 On the object pi6, select Domain 1 only.

Petzval Lens Apertures
The following commands are used to insert each of the lens apertures. The annulus clear 
aperture diameters are determined by the outer diameter of the current lens element. Each 
lens aperture is positioned at either the entrance or exit lens surface edges.

Group 1 Aperture
1 In the Geometry toolbar, click Parts and choose Circular Planar Annulus.

2 In the Settings window for Part Instance, type Group 1 Aperture in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 1 (pi1).

5 From the Work plane list, choose Surface 1 edge (wp3).

6 Locate the Boundary Selections section. In the table, enter the following settings:

Group 2 Aperture
1 In the Geometry toolbar, click Parts and choose Circular Planar Annulus.

2 In the Settings window for Part Instance, type Group 2 Aperture in the Label text field.

Name Expression Value Description

d0 1.25*d0_1 72.5 mm Diameter, outer

d1 d0_1 58 mm Diameter, inner

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz 1 1 Local optical axis, z-component

Name Keep Physics Contribute to

All √ Obstructions
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 3 (pi4).

5 From the Work plane list, choose Surface 1 edge (wp3).

6 Locate the Boundary Selections section. In the table, enter the following settings:

Group 3 Aperture
1 In the Geometry toolbar, click Parts and choose Circular Planar Annulus.

2 In the Settings window for Part Instance, type Group 3 Aperture in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 5 (pi6).

5 From the Work plane list, choose Surface 1 edge (wp3).

Name Expression Value Description

d0 1.25*d0_4 56.25 mm Diameter, outer

d1 d0_4 45 mm Diameter, inner

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz 1 1 Local optical axis, z-component

Name Keep Physics Contribute to

All √ Obstructions

Name Expression Value Description

d0 1.25*d0_6 53.125 mm Diameter, outer

d1 d0_6 42.5 mm Diameter, inner

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz 1 1 Local optical axis, z-component
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6 Locate the Boundary Selections section. In the table, enter the following settings:

7 In the Geometry toolbar, click Build All. Compare the resulting image to Figure 2.

Name Keep Physics Contribute to

All √ Obstructions
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